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1 Quick Start Recording Guide 
Complete the following steps to start recording bats with the Song Meter SMZC . 

□ Mount the recorder in a suitable location for recording (vertical orientation 
and well off the ground fro best results). 

□ Open the hinged lid to access the internal components. 
□ Verify that the pre-installed alkaline batteries and 8GB SDHC card are 

installed.  
□ (Optional) Attach the available GPS accessory to set time, date and location 

automatically. 
□ Slide the power switch down to turn the recorder ON and close and latch the 

front lid. 
□ The device powers on and shows the status screen as the memory card is 

mounted. 
□ After scanning the memory card, the Quick Start menu appears. 
□ Choose Record at Night to load the built-in Sunset to Sunrise program or 

choose Record Always to load the 24 Hours program for non-stop 
recording and press Enter to select. 

□ If this is the first time a program has been selected, you are prompted to set 
the date, time, and time zone. If you attached the available GPS accessory in 
an earlier step, the date and time are set for you automatically. You must set 
the time zone; it is not set by GPS. 

□ For the Record at Night program, you are also prompted to set the recorder 
location so as to calculate sunrise and sunset times. If you attached the 
available GPS accessory, the location is set for you automatically.  

□ Press the PROGRAM START button to start the active program on the 
recorder.  

□ You will see a series of screens showing the status of the recorder as it 
prepares to record. When recording, you will see the time of the recording 
session and ARMED when listening for bats and TRIGGER when actively 
making a recording. 

□ Hours, days, or weeks later, press and hold PROGRAM STOP for two 
seconds to finish recording. 

□ Remove the memory card and review the recordings on your computer. 
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2 Song Meter SMZC  Overview 

2.1 Introduction	
The latest generation in the Song 
Meter series, the Song Meter SMZC , 
is a completely new, professional, 
lightweight, weatherproof, cost-
effective, and reliable zero crossing 
recorder for the periodic, seasonal, or 
long-term acoustic monitoring of bats 
in any field conditions.  

You can program the device to record 
when you want for as long as you 
need. The Song Meter SMZC  has 
battery life and memory capacity to 
record for weeks. Take the portable 
device with you anywhere or mount it 
in a fixed outdoor location. 

Use the available Kaleidoscope™ 
software, sold separately, to view and analyze your recordings and automatically 
identify recorded species. For more information, visit www.wildlifeacoustics.com. 
The Song Meter SMZC is also compatible with all popular zero crossing bat 
analysis software. 

2.1.1 Features	
■ One-channel zero crossing recorder. 
■ Fully weatherproof enclosure and microphone. 
■ Lightweight and portable, you can take the device with you to record 

anywhere. 
■ Easy to set up and use. The new Quick Start menu allows you to start 

recording with just a couple button presses. Press the CHECK STATUS 
button to view the current health of the unit without interrupting 
recording. Check memory card usage, battery voltage, and more. 

■ All-in-one control panel features a weatherproof keypad for easy entry 
and feedback with a dual-color LED status lamp and a backlit LCD 
display. 

■ For advanced users, program the device on the recorder or on a PC 
using a powerful, flexible, and easy-to-use programming language. 

■ Generates its own diagnostics to assist in troubleshooting. 
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■ Internal temperature and battery voltage logging. 
■ Auto-leveling feature automatically determines the optimal zero 

crossing threshold and recalculates levels for every recording period.  
■ Records to a standard SDHC or SDXC memory card (included). 
■ Up to 40 nights of recording time from 4 alkaline C batteries (included). 
■ Integrated omnidirectional, weatherproof, low noise FG microphone. 
■ Compatible with our SMM-U1 microphone for cabled applications using 

up to 100m of cable (not included). External microphone is automatically 
detected. 

■ Internal headphone port for real-time monitoring and verification of 
system functionality. 

■ Integrated top and bottom mounting flanges are designed to work with 
radiator clamps, screws, or bungee cords. 

■ GPS accessory option automatically calculates sunset/sunrise and logs 
recording locations and path data for transects. 

■ Lowest-cost zero crossing recorder on the market. 

2.2 Zero	Crossing	Recording	
The Song Meter SMZC record bat activity using zero crossing technology. Zero 
Crossing is not the same as full-spectrum recording. In full spectrum recording, 
the recorder samples audio signals at a specified rate. Zero crossing mode 
measures the transition time between positive and negative signals relative to a 
fixed sensitivity threshold.  

The advantages of zero crossing include significantly lower power consumption 
and memory card utilization. However, zero crossing representations of bat calls 
lack information about the changing amplitude and harmonic structure of the 
underlying signal. It is possible to convert from full spectrum to zero crossing by 
removing information from the signal, but it is not possible to convert from zero 
crossing back to full spectrum. 

During the programmed recording period, Song Meter SMZC  creates zero 
crossing sequence files for each trigger. The recorder assesses each sequence to 
verify that it is a bat pass and not a non-bat trigger. You can open and analyze the 
resulting files directly in Wildlife Acoustics Kaleidoscope software or third-party 
zero crossing software. 

2.2.1 Auto-leveling	of	Zero	Crossing	Threshold	
Zero Crossing requires a sensitivity threshold that is not actually “zero”, but a level 
slightly greater than zero, and measures signal transitions that cross this threshold. 
The threshold is required because a signal devoid of bat calls will still contain 
transitions around zero as a result of ambient and electronic noise. If the threshold 
is too low, many zero crossings will be detected in a quiet signal resulting in 
significant noise. If the threshold is too high, the echolocation calls of bats may be 
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distorted or undetectable. The SMZC automatically adjusts the sensitivity 
threshold at the start of each recording period. The display will show “Auto-
leveling…” for several seconds while the level is adjusted. This allows the level to 
be optimized regularly as it is not unusual for ambient noise to change during a 
deployment. 

2.3 Updates	and	Support	
The Song Meter SMZC  is field-upgradeable. New features, fixes, and 
improvements are available in firmware updates from our website. The Song 
Meter SMZC Configurator software notifies you when new firmware is available. 

To install a firmware update file on the recorder, see 8.5 How to Update the 
Firmware. 

2.4 How	to	Join	Our	Mailing	List	
Join our mailing list to receive important news and information about your Song 
Meter and related products, features, and events. 

1. Navigate to www.wildlifeacoustics.com. 
2. Click Contact Us. 
3. Click Join Our Mailing List. 
4. Complete the online form and click Add to Mailing List. 

2.4.1 How	to	Contact	Support	
We have full-time support staff ready to assist you.  

■ Email: support2015@wildlifeacoustics.com  
■ In the United States (toll-free): 1-888-733-0200 
■ Outside the United States: +1 978-369-5225 

We have partnered with Baker Consultants, Ltd. to provide free local phone 
support services in the U.K. 

■ Telephone:  0114 360 9977 
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2.5 Song	Meter	SMZC		Visual	Tour	
Song	Meter	SMZC		Product	Diagram	

 
 

 Built-in Microphone: Standard ultrasonic microphone is ready to record with no cables or additional setup required. 

 LED Status Indicator: Displays the recording status. 

 External Microphone Connector:  Connect an SMM-U1 ultrasonic microphone and cable for remote mounting away from the recorder. 

 Bottom Hinge for Lid: Lift the hinged lid open to reveal the battery bay, memory card slot, and other internal components.  

 Mounting Flanges (Top and Bottom): Rugged and ready for outdoor adventure, use these cutouts to mount the recorder in almost any land environment. 

 Headphone Connector: Open the hinged lid to connect the optional headphones for convenient system monitoring. 

 LCD Screen and Keypad: Press the buttons on this panel to navigate the menu options on the LCD screen that configure the unit and run programs. 

 Pressure Vent: This temperature, UV, and water-resistant vent protects the enclosure against condensation, moisture, and heat exposure. 
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LCD	Display	and	Buttons	

 
 Check Status: Displays the status of the device and the current program.  

 LED Indicator: Flashes ☼ green once per second during a recording. Flashes 
☼ red once per second when waiting for a triggered recording to start. 

 Program Start: Closes any open menus and starts the current loaded program. Depending on the schedule, the device may begin recording immediately or go 
to sleep until the scheduled recording time. If a program is already 
running, pressing this button does nothing.  

 LCD Screen: Displays the menus, commands, prompts, and other details when the recorder is awake. Blank when the unit is sleeping to save power. For 
improved visibility in dark or low-light environments, press any button on 
the keypad to illuminate the LCD screen. The backlight remains lit while 
you continue operating the device and turns itself off after ten (10) 
seconds of inactivity. 

 Main Navigation Buttons: To control the recorder, press the directional arrow buttons on this panel while viewing the menu options on the LCD 
screen. Press ▲ Up or ▼ Down to navigate menus, scroll through options, or 
adjust values. Press ► Right to advance to the next submenu or multi-part 
entry. At the end of an entry, press ► Right to save your changes. 
Press ◄ Left to cancel or go back to the last menu item. Press ENTER/MENU 
to navigate menus, select options, and to confirm entries. 
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 Program Stop: Stops the current running program and returns you to the Quick Start menu. In some modes, you may need to hold the button down for a 
few seconds. 

 

Internal	Components	(Hinged	Lid	Open)	

 

 Backup Battery: Maintains real-time clock and other settings when the four (4) main C batteries are not operational. 

 GPS Connection Point: Standard RJ-11 jack for available integrated GPS unit. Cable snaps in place when inserted. 

 Integrated GPS: Synchronizes recordings on multiple recorders to within ± 0.5 milliseconds. GPS coordinates are stored in the ZC recording 
metadata. You can view them in compatible zero crossing software. Path 
information is stored in the summary file once per minute. 

 SD Memory Card: Insert and remove memory cards from the memory slot. 

 Power Switch: Slide up to turn the unit OFF. Slide down to turn power ON. (Up/down directions are given with the lid open, as shown.) 

 Battery Tray: Holds four (4) C batteries in the proper orientation. 
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2.6 The	LCD	Main	Menu		
Refer to the following table when navigating the Main Menu using the LCD screen 
and directional buttons. 

LCD	Screen	Menu	

Menu Item Description 
Quick Start[GPS:---]  
  Record at Night Load the Sunset to Sunrise program. When you press the 

PROGRAM START button, the recorder begins recording 
immediately if the time is at or past sunset. If it is 
before sunset, the unit goes to sleep until sunset. The 
recorder prompts for settings, if needed. 

  Record Always Load the 24 Hours program. When you press the PROGRAM START 
button, the device begins recording immediately. The 
recorder prompts for settings, if needed. 

  Main Menu Advance to the Main Menu where you can work with programs, 
configure settings, or run utilities 

Program  

  Select Program Choose a ready-to-run (and customizable) built-in program. 

  Edit Program Edit, add, or delete command lines in a program. 

  Import Program Import a program and associated settings from an SD card. 

  Export Program Export a program and associated settings to an SD card. 

Settings  

  Time and Date Set the local date and time for your device. 

  Prefix  Specify a short code to identify recordings from a specific 
program, project, location, or recorder. The prefix is 
especially useful to project teams with multiple recorders. 

  Latitude Specify the latitude of the recorder in degrees north (N) or 
south (S) of the equator. Latitude is used in sunrise and 
sunset time calculations. 

  Longitude Specify the longitude of the recorder in degrees west (W) or 
east (E) of the prime meridian. Longitude is used in sunrise 
and sunset time calculations. 

  Timezone UTC Set the global time zone for your device. 

Utilities  

  Export Diagnostics Display useful status and troubleshooting information, and 
save it on an SD card. 

  Set Factory Default Reset the original device settings. Restore configurations 
to their factory-fresh, like-new state. 
NOTE: Your settings are lost. 

  Calibrate Mics Test the sensitivity levels of the built-in or connected 
microphone. 

  Format Memory Card Erase and reformat the memory card. The original file system 
such as exFAT or FAT32 is preserved.CAUTION: All data on the 
memory card is permanently lost and cannot be recovered. 

  Update Firmware Update the recorder with a new firmware file that you 
downloaded and saved to a memory card. 
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3 Setup 

3.1 Overview	
The following steps summarize a typical deployment of the recorder. 

1. Push the bottom hinge of the unit down and flip the lid open to access the 
internal components. 

2. Insert four (4) size C Alkaline or NiMH batteries. 
3. Insert one (1) SDHC or SDXC memory card. 

TIP: Use the Song Meter SMZC Configurator software to estimate memory card 
requirements and power consumption for the program that you plan to run. 

4. Load one of the following types of programs on the recorder: 

■ one of two built-in programs available on the recorder 

■ a custom program that you edited on the recorder 

■ a custom program that you designed using the Song Meter SMZC 
Configurator software and then imported on a memory card.  

5. Press the PROGRAM START button. You can leave the recorder 
unattended after this step. 

6. The recorder sleeps until the next scheduled recording time. 
7. The recorder wakes at the scheduled recording start time, records audio as 

programmed, and saves recordings to the memory card. 
8. After a period of time has elapsed (it might be several hours, days, or 

weeks as estimated in the Song Meter SMZC Configurator software 
calendar view), return and check on each recorder.  

9. (Optional) To extend a deployment, exchange the memory card and install 
fresh batteries out in the field. 

10. At the end of the deployment, remove the device from its mounted 
location, eject the memory card, and examine the recorded output. 

11. Clean and prepare the recorder for its next assignment. 
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3.2 How	to	Open	the	Hinged	Lid	
To install batteries, insert a memory card, or access other available internal 
components such as the available GPS accessory, open the hinged lid. 

Steps	to	Open	the	Hinged	Lid	

 
1. Locate the handle on the lower front side of the recorder. 
2. Press down on the handle. The bottom hinge flips down. The front lid of 

the unit is now ajar. 
3. Push the entire front lid up until you can see the internal components. 

To close the lid, reverse the steps. Push the top of the lid back down and lift the 
bottom hinge so it snaps back into place. 

3.3 How	to	Turn	Power	On	and	Off	
Follow these steps to turn the power on or off. 

1. Open the lid to access the power switch. 
2. Slide the switch down to turn power ON. When you turn the power ON 

the following LCD screen appears: 
2014-Oct-14 14:50:48 
SMZC00001     R1.0.0 
CARD: 2/32   Mic: IN 
Bat  5.9V Temp 16.70 

The same information appears when the unit wakes from sleep and starts 
itself as programmed. The startup screen shows the following information: 

■ The current date in YYYY-MMM-DD format. 
■ The current time in HH:MM:SS format. 
■ The model number and serial number for the recorder. 
■ The firmware version. For example, R1.4.3. 
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■ The memory used as a fraction of the total capacity in GB. 
3. To turn the unit off, slide the switch up. 

NOTE: Do not turn the power OFF when a recording is in progress. To safely exit from 
recording, press PROGRAM STOP, allow the recorder to return to the Main Menu, 
and then switch the power to OFF. 

  

NOTE: Avoid quickly switching power OFF and then ON again. The unit can interpret 
this sudden loss and restoration of power as an error and may start diagnostics. 

3.4 Batteries	
The Song Meter SMZC uses four (4) size C alkaline or NiMH batteries, included for 
your convenience. The SMZC can record up to 40 nights using Alkaline batteries 
and up to 25 nights using NiMH batteries. The device enters a very low power 
state when not recording and, therefore, uses negligible power between 
scheduled recordings. 

Use the Song Meter SMZC Configurator software to estimate a recording 
schedule based on your program requirements. 

Prior to installation, we recommend that you test all batteries with a high-quality 
pulse load battery tester such as the ZTS MINI-MBT. 

NOTE: Do not mix batteries of different types, and do not mix old and new batteries.  

3.5 Memory	Card	
Insert a memory card to update the firmware, import or export a program, and 
save recordings. One 8 GB SDHC card is included with the recorder. You can 
expect a 8 GB to last for months if not years. 

If the recorder is unable to write to the memory card, this error appears: 

2017-Jan-31  09:00:00 
CARD FULL OR ERROR 
  ZC 8------- 

If no card is present in the memory slot, insert one. If the card no longer works, try 
setting its read/write switch to allow to the card. You can also try copying the data 
to another card or hard disk and then using a new memory card. 

NOTE: During a recording, do not remove the memory card. Replace card only when 
the unit is in sleep mode or when power is OFF. In some cases, removing and/or 
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inserting a memory card while the device is recording (often called hot-swapping) may 
cause the recorder to restart. 

3.6 How	to	Use	the	Available	GPS	Accessory	
The available GPS accessory lets you automatically set the date, time and latitude 
and longitude of the recorder. If you have several SMZC recorders to deploy in the 
field, you can use one GPS accessory to set up all recorders. 

The accessory also logs the path and location of the recorder when a recording 
was made, a useful feature when conducting mobile transects. The GPS 
coordinates are stored in the metadata of the ZC recording. You can view them in 
compatible zero crossing software. Path information is stored in the summary file 
once per minute. 

The GPS accessory consumes about 90mA of additional current. This is four times 
the current of the recorder itself. It is, therefore, recommended for passive 
recording that the GPS be used to automatically set the clock and location at the 
beginning of the deployment but not attached for the duration of the 
deployment. For driving transects, where persistent logging of recording location 
is desired, the GPS should remain attached. Deployment time using Alkaline 
batteries is reduced from about 400 hours to about 80 hours with use of GPS. 

NOTE: It can be difficult to acquire a GPS signal in thick vegetation. 

1. The Location and Time/Date Settings are automatically set by the GPS. 

NOTE: The Location Settings coordinates are read-only as long as the GPS is 
attached. You cannot change them.  

2. The recorder automatically detects the presence of the GPS. When the 
recorder wakes up, the GPS is powered up. A question mark (?) blinks 
between the date and time to indicate that the GPS accessory is 
attempting to acquire global positioning satellite data. 

2014-Oct-14?14:50:48 
SMZC00001     R1.0.0 
CARD: 2/32   Mic: IN 
Bat  5.9V Temp 16.70 

3. When the GPS has successfully acquired satellite transmission, the 
question mark changes to an exclamation point (!) and then a dollar sign 
($) indicating that the clock is now synchronized. 

4. The Song Meter SMZC  clock automatically adjusts to GPS time.  
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NOTE: If you connect a GPS accessory and are still prompted for location, date, and 
time after selecting a Quick Start program, it most likely means the GPS accessory does 
not yet have a fix. 

3.7 How	to	Set	the	Date	and	Time	
If you are not using the available GPS accessory to automatically set the current 
date and time, you can manually set these parameters.  

NOTE: The recorder does not automatically adjust for daylight savings time. 

As you adjust the month and day, the unit calculates and displays the next sunrise 
and sunset times for your reference. 

As you adjust the month and day, the unit calculates and displays the next sunrise 
and sunset times for your reference. 

1. At the Main Menu, select Settings, and press ENTER/MENU. 
2. Select Time and Date and press ENTER/MENU. 

The date and time appear on one line in the following format: 
 YYYY-MMM-DD    HH:MM:SS 
For example:  

2016-Oct-22    
20:17:45 

3. Press ENTER/MENU or ► Right. 
The cursor flashes on the last digit of the year.  

4. To adjust the year, press ▲ Up or ▼ Down. 
5. Press ENTER/MENU or ► Right to set the month. 
6. To adjust the month, press ▲ Up or ▼ Down. 
7. Press ENTER/MENU or ► Right to set the numeric day of the month. 
8. To adjust the date, press ▲ Up or ▼ Down. 
9. Press ENTER/MENU or ► Right to set the hour. 
10. To adjust the hour, press ▲ Up or ▼ Down. 
11. Press ENTER/MENU or ► Right to set the minute. 
12. To adjust the minutes, press ▲ Up or ▼ Down. 
13. Press ENTER/MENU or ► Right to set the second. 
14. To adjust the seconds, press ▲ Up or ▼ Down. 
15. (Optional) To go back and make any changes, press ◄ Left.  

Press ► Right to return to the seconds value. 
16. Press ENTER/MENU or ► Right to apply your changes. The cursor moves 

back to the first digit of the year and then applies your changes. 
17. Press ◄ Left to return to the Settings menu. 
18. Press ◄ Left again to return to the Main Menu. 
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NOTE: To accelerate the pace when adjusting the date and time values, press and 
continue to hold down the ▲ Up or ▼ Down arrow buttons. 

3.8 How	to	Set	the	Location	and	Time	Zone	
If you are not using the available GPS accessory to automatically set the latitude, 
longitude, you can manually set these parameters. The Time Zone cannot be set 
automatically by the GPS and must be set manually. The selections you make for 
latitude, longitude, and time zone enable the recorder to make adjustments and 
determine a specific sunrise and sunset time for each day. 

NOTE: When you import a program with custom coordinates, a new prefix, UTC 
settings, and other check box items from the Configuration Settings section of the 
Song Meter SMZC Configurator software, the new values from the program 
automatically replace the original settings on the recorder. 

You can specify the local time zone (as used to set the clock) in hours relative to 
UTC (Universal Time Coordinated). Half and quarter time zones (:00, :15, :30, :45) 
are also supported. 

NOTE: The recorder does not automatically adjust for daylight savings time. 

1. At the Main Menu, select Settings, and press ENTER/MENU. 
2. Select Latitude and press ENTER/MENU. 

a. To enter degrees of latitude north of the equator, press ▲ Up. 
b. To enter degrees of latitude south of the equator, press ▼ Down. 
c. Press ► Right to enter minutes for the degree of latitude using 

▲ Up or ▼ Down. 
d. Press ENTER/MENU. 

3. On the Settings menu, press ▼Down to select Longitude and press 
ENTER/MENU. 
a. To enter degrees of longitude west of the prime meridian,  

press ▲ Up. 
b. To enter degrees of longitude east of the prime meridian,  

press ▼ Down. 
c. Press ► Right to enter minutes for the degree of longitude using 

▲ Up or ▼ Down. 
d. Press ENTER/MENU. 

4. On the Settings menu, press ▼Down to select Timezone and press 
ENTER/MENU. 
a. To specify one of the time zones ahead of 0:00 UTC, press ▲ Up. 
b. To specify one of the time zones behind 0:00 UTC, press ▼ Down. 
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c. Press ► Right to specify an additional 15-minute increment adopted 
by certain regions between two time zones. 

d. Press ENTER/MENU. 

NOTE: To accelerate the pace when adjusting values, press and continue to hold down 
the ▲ Up or ▼ Down arrow buttons. 

3.9 How	to	Change	the	Prefix	for	Recorded	Files	
You can specify a filename prefix of up to 12 characters. This appears in the 
recording file names to label every recording made by a specific program or 
recorder. For example, you can use the same prefix (PROJECT-A) in a program (or 
series of related programs) to tag all recordings from all devices running that 
program. Or, you can use multiple unique prefixes on each recorder to tag 
recordings by location and device. For example, DEVICE-A, DEVICE-B, and DEVICE-
C.  

The default prefix set by the hardware is the serial number of the recorder. You 
can edit this value on each device or override the prefix with a new one in the 
program file that you create using the Song Meter SMZC Configurator software. 

Follow these steps to change the device-specific prefix: 

1. At the Main Menu, select Settings, and press ENTER/MENU. 
2. Select Prefix, and press ENTER/MENU. 
3. Specify a 1 to 12 character prefix from left to right: 

a. At the first position, press ▲ Up to cycle through the alphabetic 
characters A to Z. Press ▼ Down to cycle through the numbers 9 to 
0. You can also select a hyphen (it is above the digit 9). 

b. Press ► Right to advance to the next position in the prefix and 
repeat the previous step. 

c. To erase characters, select the blank character. It is higher than the 
hyphen and lower than the letter A. All of the characters to the right 
of the blank character are erased. 

4. When you are finished, press ► Right to advance to the last position and 
then press ENTER/MENU. 

NOTE: The prefix can only contain capital letters, numbers, and hyphens. 
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3.10 How	to	Mount	the	Recorder	
Use the top and bottom mounting holes for attaching the unit with cables, screws, 
radiator clamps, bungee cords, or other fasteners. The enclosure is fully 
weatherproof and does not require additional protection.  

NOTE: The recorder should not be deployed laying on a flat surface. This orientation 
will produce poor quality recordings as signals will bounce off the surface and cancel 
out portions of the echolocation call. This results in fragmented calls that might not 
fulfill the minimum duration of the scrubber and be deleted. 

Bungee	Cords	and	Slotted	Metal	Clamps	as	Mounting	Options	
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Mounting	Examples	-	Slotted	Clamp	(Left)	and	Screws	(Right)	

 

3.11 How	to	Connect	an	External	Microphone	
You can connect an available SMM-U1 external microphone. The SMM-U1 is a 
highly sensitive and low noise ultrasonic microphone designed for recording 
ultrasound up to 190 kHz (limited to 125 kHz when used with the SMZC). The 
microphone has a differential output, which significantly reduces noise from 
electromagnetic sources. 

SMM-U1	Ultrasonic	Microphone	

 
The external microphone connector mates with the 3-meter cable included with 
the microphone. The microphone can be extended up to 100 meters with 



Setup Song Meter SMZC User Guide 
 

 

page 18 
  
    BIOACOUSTIC MONITORING SYSTEMS 

available extension cables in 10 m and 50 m lengths with no signal attenuation or 
degradation. All connections are fully waterproof. The connector on the cable is 
keyed and the cable should be seated into the connector when oriented correctly 
and then locked into place by turning the locking ring on the microphone or cable 
P clockwise firmly until it stops. 

NOTE: Each cable is shipped with a ferrite filter to reduce electromagnetic transmission 
to nearby equipment. This is required to comply with FCC regulations but not installing 
will not adversely affect the performance of the recorder. The ferrite should be installed 
to the cable that attaches to the recorder. The cable is looped through and the ferrite 
snapped shut. A zip tie is included for further securing the filter. 

The omnidirectional SMM-U1 is ideal for unattended monitoring where the 
precise direction of bat activity is not known in advance. For applications requiring 
more directionality, the microphone can be adapted for directional sensitivity with 
the available Horn Attachment. 

The SMM-U1 microphone features a hydrophobic membrane transparent to 
acoustic or ultrasound signals to prevent unpressurized water from entering the 
microphone. In gusty windblown rain, water may pass the membrane and the 
included windscreen should be installed so as to protect the internal ultrasonic 
transducer from water damage. We also recommend positioning the microphone 
so that they point parallel to the ground, or even slightly downward, so as to 
minimize water entry. 

NOTE: Mounting cabled microphones on ungrounded non-conductive masts 
especially in dry and windy conditions, could result in damage to the microphones due 
to electrostatic build up. Please check with a professional/licensed electrician or 
installer of outdoor antennas, weather instruments or the like for advice suitable to 
your specific situation. 

See 9.5 Microphone for specifications on the SMM-U1. 

3.11.1 How	to	Connect	the	Horn	
Attachment	
The available Horn Attachment turns the SMM-U1 
omnidirectional ultrasonic microphone into a 
highly directional microphone, while preserving 
call quality. The attachment remains weatherproof 
at angles up to 45-degrees. 

3.11.2 Installing	Microphone	Windscreens	
Windscreens should be installed for long-term deployments in all areas 
susceptible to heavy wind driven rain. This could result in permanent damage to 
the microphone element due to water penetration. The risk is greater when 
deployed with the ultrasonic horn attachment. For short-term deployments with 
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predictions of less severe weather and in dry climates, you can avoid using 
windscreens. 

The windscreens will attenuate ultrasound by only a few dB when dry. However, 
they will block most ultrasound when soaked with water, until they dry. Drying 
time can vary significantly based on temperature, humidity and wind.  

Secure the windscreens for the SMM-U1 microphone with the included C-clip. 
Make sure there is an air gap between the windscreen and the microphone as 
shown below. (Do not pull the windscreen down tightly). 

 
For the SMX-Horn directional attachment, secure the large windscreen with the 
included zip-tie as shown below. Exact positioning is not important. 

 
 

3.12 Headphones	
You can use the available headphone jack to monitor bats in real time. 

1. With the lid open, insert the headphone cable into the headphone jack.  
2. Activate monitoring. 

a. If the unit is asleep, press the STOP button to stop the program, then 
press the CHECK STATUS button to activate headphone output for a 
five-minute period. When done monitoring, press Start to resume the 
schedule. 

b. If the unit is currently recording, press the CHECK STATUS button to 
activate headphone output. It will remain activated for five minutes or 
until the end of the recording, whichever is shorter. 
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3.13 Temperature	Sensor	
The recorder includes an integrated temperature sensor to log temperatures 
inside the enclosure. This is intended for diagnostics only. Heat from the circuit 
and/or heat from sun on the enclosure can significantly increase the temperature 
reading above ambient air conditions. 

3.14 How	to	Install	the	Available	Security	Cover	
The available security cover helps protect the unit from theft or vandalism. It 
covers the LCD screen, buttons, and LED lights. The cover also prevents the lid 
from opening and exposing the inside of the device. You can attach your own 
padlock and/or cable lock to prevent the device from opening and deter theft. 

If you order the Song Meter SMZC  with the security cover it will be pre-installed. 
If ordered separately, follow these steps to install it: 

1. Locate the security cover, four (4) 5/64-inch hex screws, four (4) washers, 
and L-shaped hex wrench.  
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2. On the back of the recorder, locate the four (4) pre-drilled threaded holes. 
 

 
3. Place the security cover over the holes and align the four holes.  
4. For each hole, place a washer onto a hex screw and tighten until the cover 

is attached to the back of the recorder. 
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5. Wrap the cover around the front of the device. Align the circular cut-outs 
and the rectangular slots. 
 

 
 

6. Attach a heavy-duty lock and/or cable lock 
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4 Programs 

4.1 Introduction	
The Song Meter SMZC  records in zero crossing format from one microphone. 
Programs define the operating behavior of the device including the recording 
schedule, trigger settings, and other user-configurable parameters.  

You can create and save multiple programs; however, you can only load, start, and 
optionally edit one program at a time on the recorder. You can load one of the 
built-in programs or import a program file on a memory card. You can use the 
Song Meter SMZC Configurator software on your computer to create and edit 
your own programs.  You can save a program on a memory card and import it on 
the recorder. 

This section describes how to work with programs on the recorder using the LCD 
screen, menu options, and keypad. To develop your own custom programs using 
the Song Meter SMZC Configurator software, see Chapter 5: Song Meter SMZC 
Configurator. 

4.2 How	to	Load	a	Built-In	Program	
You can load, edit, and run built-in programs directly on your recorder. The built-
in programs are designed to implement the most popular recording schedules. 
You also have the flexibility to edit one or more lines in the built-in programs to 
satisfy your specific objectives. 

1. At the Main Menu, select Program, and press ENTER/MENU. 
2. Select Select Program and press ENTER/MENU. 
3. At the Select Program prompt, press ▲ Up or ▼ Down to select one of 

the two built-in programs: 
Sunset to Sunrise 
24 hours 

4. Press ENTER/MENU. The following message appears: 
Program loaded 

5. The program that you selected is loaded onto the recorder. Next, you can 
perform any of the following actions: 

■ Edit the program. 
■ Export the program to a memory card. 
■ Start the program. 
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4.3 How	to	Edit	a	Program	
Use this procedure to edit the active, or currently loaded, program directly on the 
recorder using the LCD screen and buttons. To learn more about each command 
and available settings, see 6.1 Program Commands. 

As a general rule, we recommend that you edit programs using the Song Meter 
SMZC Configurator software; however, if you are out in the field and need to edit 
a program, this method is convenient. 

1. Load or import a program. 
2. If you already started the program, press PROGRAM STOP. 
3. At the Main Menu, select Program, and press ENTER/MENU. 
4. Select Edit Program and press ENTER/MENU. 
5. Press ▼ Down to select a line in the program. 
6. To edit the line, press ► Right to advance to the command or value and 

then press ▲ Up or ▼ Down to make adjustments.  
7. To undo your changes at this point, you can press◄ Left to return to the 

start of the line. 
8. When finished, press ► Right or ENTER/MENU and repeat until the end 

of the line has been reached and the cursor is back at the start of the line.  
9. To add or insert a line: 

a. Press ▼ Down to select the <Add/Insert> entry on the last line of 
the program and press ENTER/MENU. A new line appears at the 
bottom of the program. 

b. Press ◄ Left and then press ▲ Up or ▼ Down to change the line 
number for the new line. Press ENTER/MENU to confirm the line 
number. 

c. To edit the new line, press ► Right to advance to the command or 
value and press ▲ Up or ▼ Down to make adjustments. When 
finished editing, press ► Right or ENTER/MENU. 

10. To delete a line: 
a. Press ▲ Up or ▼ Down to select the line you want to delete. 
b. Press ► Right to advance to the command for that line. 
c. Press ▲ Up or ▼ Down until the <Delete> command appears. 
d. Press ENTER/MENU. The line is removed and all higher lines cascade 

down in sequence by one line. 
11. When finished editing all lines, press ENTER/MENU and then 

press ◄ Left.  
12. Program errors or warnings may appear. Repeat these steps to resolve 

them or press ◄ Left to ignore. Warnings can be fixed or ignored; 
however, your program will not run until it is error-free. 
a. Press ▼ Down to view the next problem.  
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b. Press ▼ Down after the last problem to return to the Program 
menu.  

c. To return to the Program menu before reviewing all the problems, 
press ◄ Left. 

13. When no errors exist, the following message appears: 
Program edit OK 

4.4 How	to	Create	a	Program	On	the	Recorder	
Instead of creating a new program line by line, take advantage of the two built-in 
programs. Use them as templates for creating your own custom programs. See 
4.3 How to Edit a Program. You can also use the SMZC Configurator software to 
create your own custom programs. 

4.5 How	to	Export	a	Program	
You can export the current program to the memory card. After exporting it, you 
can share the program with others, load it on another device, or edit it using the 
SMZC Configurator software. 

1. At the Main Menu, select Program, and press ENTER/MENU. 
2. Press ▼Down to select Export Program and press ENTER/MENU. The 

following messages appear: 
Exporting Program... 

 

Program exported 

3. Eject the memory card and examine the top-level folder contents on a 
computer or laptop. The exported file name is always the recorder prefix 
with the .PGM extension. For example: 
 
SMZC00155.PGM 

 
The default prefix is the device serial number. You can specify a new prefix 
on the recorder or in a custom program.  

CAUTION: If a file with that name already exists on the memory card, it is overwritten.  
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4.6 How	to	Import	a	Program	
Use this procedure to import a custom program file (for example, 
myProgram.PGM) from the memory card. 

1. Save a custom program to the top-level directory of a memory card from 
another recorder or from the Song Meter SMZC Configurator software. 

2. Insert the memory card in the Song Meter SMZC  recorder. 
3. At the Main Menu, select Program, and press ENTER/MENU. 
4. Select Import Program and press ENTER/MENU. 
5. At the Select Program File: prompt, press ▲ Up or ▼Down to select a 

program file on your memory card. 
6. Press ENTER/MENU.  
7. If no warnings or errors exist, the following message appears: 

Program imported 

8. If a warning or error is detected in the program, the line number and a 
short notification appear as shown in the following example: 

Program error 
Line 14 
Unreachable command:  

Warnings can be fixed or ignored; however, you must fix errors in a 
program. 
a. Press ◄ Left to return to the list of available programs. (As an option, 

you can choose a different program.)  
b. Press ◄ Left again to exit and go back to the Program menu. Edit 

the program using the recorder or Song Meter SMZC Configurator 
software and try the import again. Select Import Program when the 
program is error-free. 

9. The program that you select is imported onto the recorder and loaded as 
the active program. Press ◄ Left to return to the Program menu. 

10. You can perform any of the following actions on the imported active 
program: 

■ Edit the program. 
■ Export the program to a memory card. 
■ Start the program. 
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4.7 How	to	Start	a	Program	
Follow these steps to start the active program. The active program is the most 
recent one you loaded or imported. 

NOTE: If you press PROGRAM START and the message Empty Program! appears, it 
means you have not loaded or imported a valid error-free program. 

1. Press PROGRAM START.  
a. Errors or warnings may appear. For example: 

Program error 
 
Card slot empty 

b. Press ▼ Down to advance to the next error or warning, if any. If you 
do not press any buttons for 60 seconds, the Program Checker exits. 

c. If there is at least one error, go back to the Main Menu. Edit the 
program and fix the errors. 

d. If there are only warnings, the program starts running. Editing the 
program can often be used to resolve any warnings. 

e. Press PROGRAM START again to run the revised program. 
2. If the scheduled start time is immediately, as in the case of the Record at 

Night schedule, you will see a progression of preparation screens with the 
following status: 
a. Auto-leveling as the recorder automatically sets the zero crossing 

threshold for optimal sensitivity. 
b. Preparing to record as the recorder scans the memory card to 

assure there is sufficient space for recordings. 
c. And finally you will see the recording screen: 

2014-Oct-14 14:50:48 
Currently recording: 
14:45:39 - 15:45:35 
DIV 8 ARMED/TRIGGERED 

Where DIV indicating the division ratio, ARMED indicating that the 
recorder is waiting for a trigger, and TRIGGERED indicating that the 
recorder is actively making a triggered recording. 

3. If the scheduled start time is more than one minute into the future (three 
minutes if using the available GPS accessory), the recorder enters sleep 
mode to conserve power. You will see: 

2016-Jan-31  18:05:00 
Going to sleep. 
Next Recording at: 
2016-Feb-01  03:15:00 
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The Song Meter SMZC  wakes up 30 seconds before the scheduled 
recording start time and prepares itself before carrying out each line of the 
program.  

NOTE: If you use an AT TIME, AT SRIS or AT SSSET command that is within a daily 
repeating loop, and start the program after that time of day, the recorder will assume 
you wish to record starting at the previously occurring sunset, sunrise or time, and 
begin recording immediately. 

For example, if you have a program that starts with AT TIME 16:00:00 and records for 3 
hours, but you start the program at 17:00:00, the recorder will not wait until 16:00:00 
the next day, but instead will start recording immediately and record the remaining 
two hours of the days’ schedule. 

If you start a program with an AT TIME command that is not contained in a daily loop 
or the program starts with an AT DATE command, then the recorder will wait until the 
next specified time or date. 

4.8 How	to	Check	the	Status	of	the	Recorder	
Use the following procedure to check the status of the recorder before during or 
after starting a program. The CHECK STATUS button will toggle between the 
current screen and an information screen.  

NOTE: Always perform this procedure to check the status of the recorder and memory 
card before a deployment. 

4.8.1 While	the	Recorder	is	Sleeping	
1. Press and release the CHECK STATUS button.  
2. If you loaded a program that is scheduled to start but has not yet started, 

the unit wakes from sleep and displays the following: 
2014-Oct-14 14:50:48 
Going to sleep. 
Next recording at: 
2014-Oct-14 18:26:00 

■ The current date in YYYY-mmm-DD format. 
■ The current time in HH:MM:SS format. 
■ The time when the SMZC will wake and begin recording. 

3. Press the CHECK STATUS button again to activate the backlight and see 
the information screen: 

2014-Oct-14 14:50:48 
SMZC00001     R1.0.0 
CARD:  2/32  Mic: IN 
Bat  5.9V Temp 16.70 
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■ The current date in YYYY-mmm-DD format. 
■ The current time in HH:MM:SS format. 
■ The model number and serial number for the recorder. 
■ The firmware version. For example, R1.0.1. 
■ The memory used as a fraction of the total capacity in GB. 
■ The microphone type: IN for the Built-In microphone or U1 for 

SMM-U1 external microphone. 
■ The battery voltage. 
■ The temperature in degrees Celsius. 

NOTE: New alkaline batteries should report 6.0 or more volts. The internal temperature 
of the recorder is intended for diagnostics and not an accurate measure of outside air 
temperature. 

4. Pressing the CHECK STATUS button again will toggle though these two 
screens. The recorder will timeout after 10 seconds of no button presses 
and will go back to sleep until the next scheduled recording. 

4.8.2 While	the	Recorder	is	Actively	recording	
1. If the SMZC is currently recording, the following screen is already 

displayed: 
2014-Oct-14 14:50:48 
Currently recording: 
14:45:39 - 15:45:35 
DIV 8 ARMED/TRIGGERED 

■ The current date in YYYY-mmm-DD format. 
■ The current time in HH:MM:SS format. 
■ The start and end time of the current recording period. 
■ The Division ratio. 
■ The state of the trigger, ARMED indicating that the recorder is 

waiting for a trigger, and TRIGGERED indicating that the recorder is 
actively making a triggered recording. 

NOTE: The recording period is only the period based on the length of recording time 
selected in the program. It does not indicate the entire recording session. In other 
words, if the Record Nightly program is selected, the displayed time period only 
indicates the current 30-minute recording period, as that is the default. At the end of 
the 30-minute period a new 30-minute period will be started and this will continue 
until sunrise. 

2. Press the CHECK STATUS button again to activate the backlight and see 
the information screen, as described in the previous section. 

3. Pressing the CHECK STATUS button again will toggle though these two 
screens. The recorder will timeout after 10 seconds of no button presses 
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and will go back to the recording status screen. The backlight will timeout 
after 10 seconds. 

4.9 How	to	Stop	a	Program	
Press and hold the PROGRAM STOP button for several seconds while a program 
is running or scheduled to run to stop it from continuing. When you stop a 
running program, the recorded output up until recording was stopped is saved to 
the memory card. 

When you press PROGRAM STOP you are only stopping the current instance of 
that program. The program will start itself and resume recordings as 
programmed. To stop all recording, you can power the unit off.  
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5 Song Meter SMZC Configurator 

5.1 Introduction	
Use the Song Meter SMZC Configurator software to create and edit recording 
programs for the recorder. You can also use this application to perform the 
following tasks: 

■ Estimate battery life and memory capacity for recording deployments. 
■ Open a recording to view the commands and settings used in the 

original program that captured it. 
■ Edit and save your own versions of a program and use them on future 

deployments to one or more SMZC recorders.  
The software is available for Microsoft Windows, Apple Mac OSX, and Red Hat 
Linux and can be downloaded for free at: 
http://www.wildlifeacoustics.com/support/download-software. 

5.2 Song	Meter	SMZC	Configurator	User	Interface		
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Song	Meter	SMZC	Configurator	Software	

 File and Help Menus: Click the File menu to load a sample program, open one of your own programs, save a program, or exit. Click the Help menu and 
choose About to view the currently installed version number of the utility. 

 Configuration Settings: Adjust the settings in this section to override the settings on the recorder when you import the program. 

 Program: Enter your choice of commands and adjust their parameter values to create, edit, and save your own custom programs. Any warnings or errors 
appear below the program. 

 Deployment Scenario: Estimate the timeline of your deployment settings including Start date, battery power, and memory capacity. 

 Scrolling Calendar View: Use this section to explore the estimated recording schedule, battery life, and memory card requirements of your 
program. Black bars represent successful recordings; purple bars require 
more memory; and red bars represent insufficient power. Blue and yellow 
shading indicates night and day based on program settings. 

 Status Bar: When you drag your mouse pointer in the schedule, the status bar displays details about that point in the program. From left to right, 
it shows the recording date, approximate time, estimated recording duration 
for that particular segment of the program, cumulative power consumption, 
memory card utilization (by segment and in total), recording file type 
(ZC), channels (0), and division ratio (DIV 4, 8, or 16). 

 

5.3 How	to	Create	a	Program	in	the	Configurator	
Although you can create a new program starting at line one, as a time-saving best 
practice use this procedure to create a new program from one of the sample 
programs provided as a template. 

TIP: Start by loading one of the sample programs and then make adjustments to 
create your own custom programs. 

1. Open the Song Meter SMZC Configurator software application. 
2. Click the File menu and choose one of the sample programs: 

■ Sunset to Sunrise 
■ 24 hours 

3. In the Program section, examine each line of the program. Use the drop-
down value lists to edit fields. You can use the mouse or press the Tab key 
to advance to the next field. Press Shift+Tab to go back to the previous 
field. Press the arrow keys on your keyboard to cycle through value lists.  

4. To change a command in any line, select another command from the list. 
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5. The last line in a program is empty and shows <Choose> in its command 
field ready for you to specify a command. To insert a new line, click a line 
number. 

6. To remove a line, select <Delete> in the command field.  
7. (Optional) Adjust the Configuration Settings section to override the 

settings in the recorder. 
8. (Optional) Adjust the Deployment Scenario section to estimate a 

recording schedule. 
9. Resolve any errors that appear below the Program section. 
10. Click the File menu and choose Save. 

a. Save the program to your computer to continue editing it or to use it 
as a template for future programs. You can open your saved program, 
edit it, and save over the old name or give it a new name. 

b. Save the program to a memory card to import it onto one or more 
recorders in the field. 

5.4 How	to	Adjust	Configuration	Settings	
Select any of the check boxes in the Configuration Settings section to override 
any values already set on an individual Song Meter SMZC  unit when you import 
your program. For example, select the Prefix check box and enter a new prefix for 
a location or project name. 

All of the settings in this section are documented elsewhere in this guide. 

5.5 How	to	Adjust	Deployment	Scenario	Settings	
Use the fields in the Deployment Scenario section to estimate the recording 
schedule for the program in the calendar view. 

1. Load a sample program or a custom program. 
2. In the Start fields enter the date and time in the following format: 

DD/MM/YYYY   HH:MM:SS 
3. In the Memory Card field, select the capacity of the memory card. 
4. In the Mic field, select the type of microphone you plan to use: the built-in 

internal microphone or the SMM-U1 external microphone. 
5. In the Trig Ratio (%) field, indicate the percentage of time during 

recording periods that a given microphone will be triggered. The default 
value of 10% is a good estimate for bat recordings. Adjust as needed 
based on past experience with your specific recording conditions. 



Song Meter SMZC Configurator Song Meter SMZC User Guide 
 

 

page 34 
  
    BIOACOUSTIC MONITORING SYSTEMS 

6. In the Power (mAh) field, enter your batteries capacity in milliamp hours. 
This is the capacity from just one battery. Do not add up four capacities for 
four batteries as the capacity is given for only that cell’s voltage. 

7. Examine the recording calendar and make any adjustments to fit your 
timeline. 

8. Click the File menu and choose Save. Save the resulting .PGM file to a 
memory card. 

9. Import the program onto the recorder. See 4.6 How to Import a Program 
on page 26. 

5.6 How	to	Use	the	Scrolling	Calendar	
The scrolling calendar in the lower portion of the application window shows the 
recording schedule for over a year (400 days to be precise) from the Start date in 
the Deployment Scenario section. Successful recording periods are shown with 
black bars. Blue shaded areas represent nighttime and yellow shaded areas 
represent daytime based on sunrise/sunset calculations determined by the time 
zone (hours relative to UTC), latitude, and longitude specified in the 
Configuration Settings section.  

The scrolling calendar also illustrates when the Song Meter is likely to stop 
recording after running out of memory storage (purple bars) or battery power (red 
bars). These are estimates based on the memory card and battery capacity 
specified in the Deployment Scenario section. Actual performance is subject to 
variations in memory card and battery manufacturers and numerous other factors 
such as temperature or battery charging method. 

To estimate memory requirements for triggered recordings, set the Trig Ratio 
(%) field in the Deployment Scenario section. The application estimates memory 
consumption based on how often the unit is likely to be triggered and truly 
recording as opposed to waiting for a trigger to start recording. The default value 
of 10% is good for bat recording. You can adjust this ratio based on personal 
experience with your specific recording conditions. 



Song Meter ZC User Guide Developing Custom Programs 
 

 

 page 35 
BIOACOUSTIC MONITORING SYSTEMS 

6 Developing Custom Programs 

6.1 Program	Commands	
Use the following commands to create programs for your specific recording 
needs. Or use the following as a guide to modify an existing program to better 
suit your needs. A program can contain up to 99 command lines.  

TIP: Start by loading one of the sample programs and then make adjustments to 
create your own custom programs. 

DIV {4,8,16}  

Use this command to specify the data division ratio for zero crossing 
recordings. The choices are 4, 8 or 16. 

We recommend a value of eight (8). This is the value used in Kaleidoscope 
software’s Auto-Identification algorithms and is optimal for most 
applications. 

A division of 16 will provide less detail and use less memory card space, but 
zero crossing is already such a compact format there is no longer a 
compelling reason for that compromise. 

A division of 4 will show more detail, but the additional “dots” tend to lack 
accuracy as they are not averaged as much over time. This division could be 
useful for bats with very short duration echolocation calls or calls with very 
low frequency. 

TRGWIN [0.1-9.9] 

Use this command to set the recording duration after a triggering signal. 
The recording continues for this amount of time after the last signal that 
satisfies the trigger. If the only such signal is the signal that causes the 
trigger, then the duration of the recorded file matches the length of this 
setting. Otherwise, the length of the recording is longer than the last trigger 
signal by this amount. The recording is truncated when it reaches the 
maximum recording duration set by TRGMAX (see below). 

The available range is 0.1 to 9.9 seconds in 0.1 second increments. Set this 
value long enough to avoid a recording that ends after one echolocation 
call. If a bat's echolocation calls occur every 0.5 seconds and this was set to 
0.1 seconds, you would get a new trigger with every single echolocation call. 
Three (3.0) seconds is a good default value.  



Developing Custom Programs Song Meter SMZC User Guide 
 

 

page 36 
  
    BIOACOUSTIC MONITORING SYSTEMS 

NOTE: Some standards describe a specific recording trigger window as a bat pass.  

TRGMAX [OFF,00.1-99.9] 

Use this command to set a maximum recording duration.  

The available range is from 0.1 to 15.0 seconds in 0.1 second increments.  

FRQMIN [OFF,1K-192K] 

Use this command to set the lower bound for the frequencies of interest to 
the scrubber and the triggering mechanism. The available range is from 1 to 
192 kHz in 1-kHz increments, or OFF 

Echolocation calls or other signals occurring below this frequency will not 
cause a trigger and will be considered noise to the scrubber mechanism. A 
setting of 16 kHz works well for most bat applications but it may be 
necessary to set lower if lower frequency species will be recorded. 

See DMIN for more information on how the scrubber uses this value. 

FRQMAX [OFF,1K-192K] 

Use this command to set the upper bound for the frequencies of interest to 
the scrubber and the triggering mechanism. The available range is from 1 
to192 kHz in 1-kHz increments, or OFF.  

Echolocation calls or other signals occurring above this frequency do not 
cause a trigger and are considered noise to the scrubber mechanism. A 
value of 192 kHz is recommended for recording bats. 

See DMIN for more information on how the scrubber uses this value. 

DMIN [OFF, 000.1-800.0]  

Use this command to set the minimum duration for a signal in the specified 
frequency range to be a valid signal to satisfy the scrubber. The available 
range is from 0.1 to 800.0 milliseconds in 0.1-millisecond increments, or 
OFF.  

The scrubber automatically deletes files where no suitable bat echolocation 
call is detected. The scrubber looks for at least two narrow band signals of at 
least this DMIN duration and shorter than DMAX and within the frequency 
range specified by FRQMIN and FRQMAX. If two such signals exist, the file 
is saved, if they are not, the file is not saved. 

A value of 1.5 ms is recommended for recording bats.  

Setting this command to OFF will not scrub files based on a minimum signal 
duration. 
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The files are scrubbed based on this field and DMAX. If you do not want to 
scrub files, set this command and DMAX to OFF.  

DMAX [OFF, 000.1-800.0] 

Use this command to set the maximum duration for a signal in the specified 
frequency range to be a valid signal to satisfy the scrubber. The available 
range is from 0.1 to 800.0 milliseconds in 0.1- millisecond increments, or 
OFF. 

A value of 200 ms is recommended for recording bats. 

Setting this command to OFF will not scrub files based on a maximum 
signal duration. 

See DMIN for more information on how the scrubber uses this value. 

RECORD hh:mm:ss 

Starts a triggered recording period of the specified duration. Individual zero 
crossing files are saved directly to the memory card. If the RECORD 
command is inside a repeat/until loop, the recording period may end early 
to match the outer loop ending time. 

Auto-leveling of the zero crossing threshold is performed at the beginning 
of each recording session for optimum sensitivity. 

PAUSE hh:mm:ss 

Pauses the program for the specified amount of time. If you set the duration 
of the PAUSE command to greater than 1 minute, the Song Meter SMZC  
enters low-power sleep mode and wakes up at the next scheduled 
recording. 

AT DATE DDMMMYY  

Causes the program to wait until the specified date. YY are the last two 
digits of the year in the current century beginning with the year 2000. 

NOTE: Technically this command acts as an “at or After” command. If you start the 
program after the specified AT DATE, the command is ignored and the program 
continues.  

AT TIME hh:mm:ss 

Causes the program to wait until the specified date time.  

NOTE: If you use an AT TIME, AT SRIS or AT SSSET command that is within a daily 
repeating loop, and start the program after that time of day, the recorder will assume 
you wish to record starting at the previously occurring sunset, sunrise or time, and 
begin recording immediately. 
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For example, if you have a program that starts with AT TIME 16:00:00 and records for 3 
hours, but you start the program at 17:00:00, the recorder will not wait until 16:00:00 
the next day, but instead will start recording immediately and record the remaining 
two hours of the days’ schedule. 

If you start a program with an AT TIME command that is not contained in a daily loop 
or the program starts with an AT DATE command, then the recorder will wait until the 
next specified time or date. 

AT SRIS±hh:mm:ss 

Causes the program to wait until sunrise, plus or minus the specified time.  

AT SSET±hh:mm:ss 

Causes the program to wait until sunset, plus or minus the specified time. 

REPEAT 

Indicates the beginning of a repeat until loop and must be ended by an 
UNT command. See next section for details on loops and how they work. 

UNTDATE DDMMMYY 

Ends a loop when the specified termination date is reached. Any RECORD 
commands in progress in this loop are forced to stop recording. 

UNTTIME hh:mm:ss 

Ends a loop when the specified termination time is reached. Any RECORD 
commands in progress in this loop are forced to stop recording. 

UNTSRIS±hh:mm:ss 

Ends a loop at sunrise, plus or minus the specified time. Any RECORD 
commands in progress in this loop are forced to stop recording. 

UNTSSET±hh:mm:ss 

Ends a loop at sunset, plus or minus the specified time.  Any RECORD 
commands in progress in this loop are forced to stop recording. 

UNTCOUNT [INF,01-99] 

Ends a loop after <count> iterations. INF specifies an infinite count. 

FEATURE <feature number> {OFF,ON} 

This is for advanced use only and is not a required command by the 
program checker.  The first parameter is a number from 1 to 16 and the 
second parameter is OFF or ON. By default, all features are OFF.  
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■ FEATURE #01: If ON, disables the LED blinking during recording.  Insert 
into the top of a program "01 FEATURE 01 ON" to disable the LEDs. 

This command may be used to add additional features in the future. 

6.2 Loops	
An essential logical structure in any computer program, a loop repeats a task until 
an ending condition is met. For example, you need a program that waits, and 
continues to wait until sunset; and then you want it to record, and repeat that 
action, recording over and over (we call that a loop) until 15 minutes before 
sunrise. 

Loops are programmed by using a pair of REPEAT and UNT commands. Loops 
can be nested such that a pair of REPEAT and UNT commands can contain pairs 
of REPEAT and UNT commands within. Loops have an explicit ending condition, 
such as a date for an UNTDATE command or a count for an UNTCOUNT 
command. In addition, loops have an implicit ending time, inherited from any 
enclosing loops. The implicit ending time is the earliest of all the enclosing loop 
ending times. In other words, the ending condition of a loop is either its own 
ending condition or the implicit ending time, whichever occurs first. 

RECORD commands likewise inherit an implicit ending time from any enclosing 
loops, perhaps causing a RECORD command to finish earlier than indicated by its 
own duration parameter. 

UNTCOUNT loops do not have an ending time of their own, although they do 
adhere to any implicit ending time that they inherit. If a program contains just one 
loop, a REPEAT/UNTCOUNT loop, with a RECORD command inside that loop, 
then the RECORD command will always run for its full duration, and the loop will 
end after the specified count of iterations. 

6.3 How	to	Work	With	the	Program	Checker		
The Program Checker runs automatically to verify the configuration of the 
hardware and software, and to check your program for errors or warning 
conditions. If it detects contradictory commands, the Program Checker reports the 
latter of the two as the error source. Use the Program Checker output to correct 
your program, save it, and then attempt to import or run it again. 

1. The Program Checker runs at all of the following times: 
■ After you finish loading or importing a program. 
■ After you finish editing a program and press the main buttons on 

the device to exit the editor as viewed through the LCD screen. 
■ Before you run a program by pressing the PROGRAM START button. 
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2. The Program Checker performs several tests on the current program. For 
example, it checks for the following items: 

■ Balanced REPEAT/UNTX loops 
■ At least one RECORD command that is reachable; in other words at 

least one RECORD precedes, or is inside of, an infinite loop. 
■ All required parameters set prior to a RECORD command. 
■ Parameters that are consistent with the present hardware. 

3. It shows errors (if any), followed by warnings (if any). It shows the matching 
line number in your program for the error or warning. 

4. To view the next error or warning, press the ▼ Down button. 
5. To exit the Program Checker, press the ◄ Left button. You can also exit by 

pressing ▼ Down after the last error or warning. 
6. If no buttons are pressed for 60 seconds while a problem is displayed, the 

Program Checker times out and exits. 
7. When the Program Checker exits: 

■ If you were loading or editing a program, you return to the Main 
Menu. 

■ If you were running a program and there are no errors (only 
warnings or no problems at all), your program starts. 

6.4 How	to	Resolve	Program	Checker	Errors	
When a program contains warnings, you can address them or even choose to 
ignore them and continue. However, when a program contains one or more 
errors, it will not run. To resolve an error, edit the program and adjust a parameter 
or add, move, or delete a command line. Refer to the following list of the most 
common program warnings and errors. 

Song	Meter	SMZC		Common	Program	Warnings	and	Errors	

Message Warning/Error Explanation 

Unmatched REPEAT:  error  A REPEAT command for which no corresponding 
subsequent UNT_X command can be found. 

Unmatched UNTX:  error An UNT_X command for which no corresponding 
preceding REPEAT command can be found. 

Inf lp bfr REC:  error  The program has an infinite loop before 
reaching any RECORD command. 

Unreachable command:  warning  The program contains an infinite loop. 

No RECORD:  error  The program contains no RECORD command. 
No DIV cmd:  error A RECORD command has been reached with no 

preceding DIV command. 
No FREQMIN cmd:  error A RECORD command has been reached with no 

preceding FREQMIN command. 
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Message Warning/Error Explanation 

No FREQMAX cmd:  error  A RECORD command has been reached with no 
preceding FREQMAX command. 

No DURMIN cmd:  error  A RECORD command has been reached with no 
preceding DURMIN command 

No DURMAX cmd:  error A RECORD command has been reached with no 
preceding DURMAX command. 

No DTRGWINDOW cmd:  error  A RECORD command has been reached with no 
preceding DTRGWINDOW command 

No DTRGMAXLEN cmd:  error  A RECORD command has been reached with no 
preceding DTRGMAXLEN command. 

FREQMAX <= FREQMIN:  error  A RECORD command has been reached, and the 
preceding FREQMAX value is less than or equal 
to its preceding FREQMIN value. 

DURMAX <= DURMIN:  error  A RECORD command has been reached, and the 
preceding DURMAX value is less than or equal 
to its preceding DURMIN value. 

Extern mic not 
ultra:  

run-time 
warning  

A RECORD command has been reached and the 
external microphone is not a ultrasonic.  

Card slot empty error No memory card is installed. 
Card is read-only error The memory card has the read-only switch on. 
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7 ZC Recording Details 

7.1 Filenames	for	Recordings	
Audio recording files are saved in a Data folder on each memory card and use the 
following naming conventions: 

PREFIX_0_YYYYMMDD_HHMMSS.00#  

PREFIX 

The prefix is set in the SETTINGS menu or in the Song Meter SMZC 
Configurator. 

_0_ 

Indicates a mono recording to maintain consistent format in order to assure 
compatibility with Kaleidoscope and other software. 

YYYYMMDD_HHMMSS 

The full timestamp including the year, month, day, hour, minute, and second 
when the recording started. 

.00# 

The filename suffix for zero crossing recordings. 

7.2 Recording	Metadata	
In addition to the information available in the filename, values for the attributes 
listed below are stored as metadata in your ZC recording files. This information is 
visible in the available Kaleidoscope software as well as third party zero crossing 
analysis software. 

NOTE: Kaleidoscope software supports additional metadata relating to analysis of the 
recording and allows you to change some of the metadata fields. 

Timestamp 

This is the full timestamp including the year, month, day, hour, minute, 
second and, microseconds when the recording started. This is stored in the 
following format: 
Timestamp: YYYY-MM-DD HH:MM:SS.mmm 

Latitude and Longitude 
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The location of the recorder at the start of the recording. This is stored in the 
following format: 
GPS: XX.XXXXX N [or S] XX.XXXXX W [or E] 

NOTE: This only stored if the available GPS sensor is attached and has a fix during the 
recording. Manually entered latitude and longitude are not stored. 

Device Model and Serial Number 

This is stored in the Notes field in following format: 
 TAPE: SMZ00001 

Auto-Level Value 

This is a measure of the zero crossing threshold level. This voltage setting is 
relative to full scale at the microphone inputs. It is stored in the notes field in 
the following format: 
 SPEC: Level: - 84.1dBV 

7.3 Summary	Text	File	
Once per minute during a recording period, the recorder appends a line of text to 
the summary text (.txt) file. The summary file logs basic parameter values 
separated by commas for easy viewing later in Excel or a text editor. The file 
begins with a header line which identifies the fields that appear in each line of 
summary data in the rest of the file: 

DATE,TIME,LAT,,LON,,POWER(V),TEMP(C),#FILES,#SCRUBBED,MICTYPE 

As examples, three lines from a sample summary file appear below: 
2016-Jan-22,17:15:24,42.00000,N,71.00000,W,5.9,12.00,2,1,IN 
2016-Jan-22,17:16:38,42.20000,N,71.10000,W,5.9,11.75,3,4,IN 
2016-Jan-22,17:17:47,42.35000,N,71.18200,W,5.5,11.75,1,2,IN 

 

Date and Time 

The date of each entry in the file is stored in the format YYYY-MMM-DD. 
The time of each entry appears in a 24-hour format HH:MM:SS that includes 
minutes and seconds. 

Latitude and Longitude 

The latitude and longitude are stored with single characters to designate 
direction (N, S, E, or W). These coordinates are set by the user manually or 
dynamically calculated by the available GPS accessory. The GPS location of 
each recording is stored in the recording metadata only if the available GPS 
sensor is attached and has an accurate satellite reading during the 
recording.  
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Power 

The power supply voltage for the batteries are logged. In the example, the 
voltage is 5.9 volts. 

Temperature 

The file stores the temperature in degrees Celsius. In our example, the 
internal temperature has fallen from 12.0 to 11.75 degrees. 

Number of ZC Files Saved 

This is the number of ZC files recorded and written to the memory card 
since the last entry. In the example 2, 3, and 1 files were recorded during 
each respective one-minute period. 

Number of Scrubbed Files 

This is the number of ZC files that were scrubbed based on the program 
settings. These files were not written to the memory card since the last 
entry. In the example 1, 4, and 2 files were scrubbed during each respective 
one-minute period. 

Microphone Type  

The file stores the microphone type: IN for the Built-In microphone or U1 for 
SMM-U1 external microphone. 

7.4 Kaleidoscope	Software	
The free version of the Kaleidoscope post-processing software from Wildlife 
Acoustics can convert .wac, .wav, and zero crossing formats while filtering out 
unwanted signals. Upgrade to Kaleidoscope Viewer to view spectrograms of your 
bat recordings. Upgrade to Kaleidoscope Pro to add automatic classification of 
bats (includes Kaleidoscope Viewer). 

1. Navigate to http://www.wildlifeacoustics.com/support/download-software. 
2. Find the file appropriate for your operating system. 
3. On Windows, open file and follow installation instructions. On Mac copy 

the file to the Applications folder. 
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8 Utilities 

8.1 How	to	Run	Diagnostics	
Use this procedure to generate diagnostic information about the current state of 
the recorder and the current program. Use the diagnostic information to 
troubleshoot any problems you may be experiencing. When contacting customer 
support, a representative may ask you to provide this information to help 
diagnose the problem. 

1. Insert a memory card into the recorder. 
2. At the Main Menu, select Utilities, and press ENTER/MENU. 
3. Select Export Diagnostics and then press ENTER/MENU. 
4. The unit performs internal diagnostic tests and then exports the following 

information in a log file to the memory card: 
■ current settings and configurations 
■ current program 
■ other diagnostic information 

Note: You can also press and hold ▼Down while	powering	the	unit	ON	to	activate the 
diagnostics utility. 

5. Remove the memory card and identify the diagnostic file by the following 
format: 
PREFIX_YYYYMMDD_hhmmss.smzcdump 

 
A support professional can use the file to help you troubleshoot issues. You can 
open the file in the SMZC Configurator software to view the original program. 

8.2 How	to	Reset	Factory	Default	Settings	
This short procedure restores the original device settings set as default values at 
the factory when your recorder was first assembled and tested. 

1. At the Main Menu, select Utilities, and press ENTER/MENU. 
2. Select Set factory default and then press ENTER/MENU. 
3. At the Confirm: Set dflt? prompt: 

a. Select No to cancel this entire procedure and continue operating the 
Song Meter SMZC  with its current settings. 
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b. Select Yes and press ENTER/MENU to restore the device to its 
original factory default settings. 

CAUTION: All custom settings, including, location, and prefix, are erased.  

8.3 How	to	Test	Microphones	
Use the available Ultrasonic Calibrator to calibrate the built-in microphone or an 
attached SMM-U1 microphone. Since ultrasound is beyond the range of human 
hearing, verifying proper system and microphone performance can be a 
challenge. The Ultrasonic Calibrator helps you test both the microphone and the 
full recorder system. 

The Calibrator requires a 9V alkaline battery (1.5V cell) and one is included with 
the unit. The battery is located behind the hinged door at the top of the unit. The 
LED will no longer illuminate when the battery is depleted and can no longer 
provide a calibrated tone. While the unit may still emit sound at this point, it 
cannot be used as an accurate calibrator if the LED is not illuminated. 

The calibrator has two modes of operation:  
■ CAL: Calibration mode is used to test the microphone at close range. 
■ CHIRP: Chirp mode is used to test the entire system at a greater 

distance. 

8.3.1 Entering	Calibration	Mode	
To test a microphone, the calibrator generates a calibrated 40 kHz tone. 

1. At the Main Menu, select Utilities, and press ENTER/MENU. 
2. Select Calibrate Mics and then press ENTER/MENU. Wait a moment for 

the following screen to appear: 
MICROPHONE CALIBRATE 
 
@40KHZ = ------dBv 
 

3. Turn the calibrator ON and set the mode switch to CAL. 
You are now ready to test the built-in microphone or an attached SMM-U1 
Ultrasonic microphone. 

8.3.2 Testing	the	Built-in	Microphone	
1. Remove the clear calibrator microphone adapter by sliding it of the 

calibrator from the bottom (the end with the Wildlife Acoustics logo). 
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2. Place the calibrator flush with the top of the SMZC housing such that the 
ultrasonic transducer is pointing downwards towards the built –in 
microphone. Make sure it is flush with the angled bevel such that it is 
pointed slight downward.  

 
 

3. Set the toggle switch to CAL. 
4. Look at the dBv level shown on the SMZC screen. If the value is higher (less 

negative) than -45 dB your microphone is within specification and ready 
to use. If the value is lower (more negative) than your microphone has lost 
some or all of its sensitivity and should be repaired.   

5. Press the ◄ Left button when finished to leave calibrate mode. 

8.3.3 Testing	an	Attached	SMM-U1	Ultrasonic	Microphone	
1. Install the clear calibrator microphone adapter by sliding it onto the 

calibrator from the bottom (the end with the Wildlife Acoustics logo) until 
it is touching the toggle switches.  

2. Set the toggle switch to CAL. 

 
3. Place the microphone in the calibrator microphone adapter. Make sure 

that the side with the smaller hole diameter is near the toggle switches. 
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Insert the microphone until it rests against the smaller opening of the 
adapter hole. 

 
 

 
4. While looking at the dBv level shown on the SMZC screen, slowly rotate 

the microphone 360 degrees. Note the largest (least negative) number. 
5. If the value is higher (less negative) than -38 dB your microphone is within 

specification and ready to use. If the value is lower (more negative) than 
your microphone has lost some or all of its sensitivity and should be 
replaced.   

6. Press the ◄ Left button when finished to leave calibrate mode. 

8.3.4 Testing	the	System	Using	Chirp	Mode	
To test the system, the Ultrasonic Calibrator can emit loud ultrasonic signals to the 
recorder while it is recording from some distance. Analyze these recordings to 
verify that the recorder settings are appropriate and the system is functioning as 
expected.  

1. Remove the microphone adapter from the calibrator. 
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2. Set the toggle switch to CHIRP. 
3. The unit will emit a 100ms 40khz (+/- 10Hz) tone every 500ms. The 

amplitude of the tone is 104dB SPL (+/- 3dB) at 10cm. The signal can be 
picked up by the SMZC at distances up to 20 meters. Begin recording and 
view recordings or monitor with headphones to verify that the signal is 
being picked up. 

WARNING: Do not place the Ultrasonic Calibrator near your ears! In CHIRP mode, the 
calibrator emits a 40 kHz signal at over 100 dB SPL. Prolonged exposure to high 
intensity ultrasonic signals may cause permanent hearing loss at audible frequencies.  

8.4 How	to	Erase	and	Format	a	Memory	Card	
This procedure erases and formats the installed memory card. Use this procedure 
prior to all deployments for optimal performance.  

WARNING: This procedure erases all data files on the memory card. Verify that you 
have imported, saved, or copied any important programs and backed up any 
important recordings stored on the memory card before running this utility. 

1. Open the hinged front lid and insert a memory card. Verify batteries are 
installed and the power switch is ON (down). 

2. At the Main Menu, select Utilities, and press ENTER/MENU. 
3. Select Format Memory Card and press ENTER/MENU. 
4. At the Confirm: Format now? prompt, choose one of the options: 

■ Press ► Right to select No and cancel this 
entire procedure. Any existing data files 
remain on the memory card. 

■ Press ▼ Down to select Yes and press 
ENTER/MENU to format the  memory card. 
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5. If you select Yes, the progress appears and then the screen resets to the 
last selected submenu. 

6. With a clean and formatted memory card, you now have the maximum 
available space on the card and are ready to start a program and save 
recordings. 

8.5 How	to	Update	the	Firmware	
When a new firmware update is available, download and install it to update your 
recorder. 

1. Navigate to http://www.wildlifeacoustics.com/support/download-software. 
2. Click Support and then click Downloads. 
3. Complete the online form and click Request Downloads. 
4. Select the latest Song Meter SMZC  firmware update file to download it. 
5. (Optional) You can also access the following downloads: 

■ Song Meter SMZC Configurator software 
■ Kaleidoscope software for sound file 

conversions 
6. Save or copy the firmware file to the top level of a memory card and insert 

into the recorder. 
7. At the Main Menu, press ▲ Up or ▼Down to select Utilities and then 

press ENTER/MENU. 
8. Press ▲ Up or ▼Down to select Update Firmware and then press 

ENTER/MENU. The recorder scans the memory card for .smzc files. 

TIP: You can also press and hold ▲ Up while powering the unit ON to activate the 
firmware update menu.  

9. At the Select upgrade file prompt, select the firmware update file that you 
want to apply and press ENTER/MENU. The following message appears: 

Upgrading.......... 
UPGRADE COMPLETE! 
 
Rebooting 

The system applies the new firmware and restarts. 

NOTE: There is no way to exit the Update Firmware screen other than updating with a 
file or powering the SMZC off and back on again (leaving it off for five seconds). 
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9 Specifications 

9.1 Physical		
	

Length/Height: 11.5 inches (290 mm) 
Width: 5.0 inches (125 mm) 

Depth: 2.8 inches (71 mm) 
Weight: 2.2 pounds (1.0 kg) 

Weight with 4 Batteries: 2.8 pounds (1.3 kg)  

Operating Temperature: -4°F to 122°F (-20°C to 50°C) 
Enclosure: Fully weatherproof. A pressure vent and 

a self-regenerating humidity control 
prevent condensation.   

9.2 Power	
Battery Specifications: The recorder uses four (4) standard C size disposable 
alkaline batteries or rechargeable NiMH batteries. Battery life can vary widely 
depending on the battery type, brand, charger, temperature, and other factors. 
The following battery longevity is typical and assumes 10-hour nights: 

■ Alkaline batteries (8,000 milliamp hours at 1.5V each): 40 nights 
■ NiMH batteries (5,000 milliamp hours at 1.2V each): 25 nights 

Power Consumption: 0.5 mW sleeping and 100 mW recording 

Clock Backup Battery Type: CR2032 (approximately 3-year life) 

Internal Clock Accuracy: Temperature-Compensated Crystal with 3.5ppm drift 
from -40°C to 0°C and 2.0ppm from 0°C to 40°C 

9.3 Memory	Card	
Memory: Up to 32 gigabytes (SDHC) or up to 256  gigabytes (SDXC). This is the 
maximum currently available; higher capacities may be available in the future. 

Formats: FAT32 for SDHC or exFAT for SDXC 
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9.4 Ultrasonic	Audio	
Channels: 1 

Recording format: zero crossing 

Amplifier Gain: 60 dB 

Anti-alias filter: 2-pole at 156 kHz 

Maximum Recordable Frequency: 125 kHz 

9.5 Microphones	

9.5.1 Built-In	
Element: Knowles FG 

Built in high pass filter: 4-pole at 8 kHz 

Frequency response: As SMM-U1 shown below. 

Directionality: As SMM-U1 shown below but attenuated from behind the 
enclosure. 

9.5.2 SMM-U1	Ultrasonic	
Enclosure: Weatherproof stainless steel 

Directionality: Omnidirectional 

Element: Knowles FG 

Output: Differential 

Built in high pass filter: 4-pole at 8 kHz 
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10 Firmware Release Notes 
1.0.1 (Initial release) 

1.0.3 (March, 2015) 
■ Fixes a freeze that could occur when exiting the Check Status screen with a 

program running. 
■ Fixes the log file buffer size for correct diagnostic dumps. 

1.0.6 (June, 2015) 
■ Improved the interpretation of programs containing non-infinite loops. 
■ Further improvements to compatibility with certain SD cards. 
■ Reduced gain on headphone output and reduced time-out period to save 

power. Output will now automatically turn off at the end of a recording 
period or after 5 minutes, whichever comes first. 

■ Lengthened the check status display timeout to 10 seconds. 
■ Fixed redundant summary file entries.  
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11 Warranty and Disclosures 
Except	 as	 specifically	 provided	 herein,	 Wildlife	 Acoustics	 makes	 no	 warranty	 of	 any	 kind,	
express	or	implied,	with	respect	to	this	product.	

11.1 Wildlife	Acoustics,	Inc.	Limited	Warranty	
	
Hardware:	Wildlife	Acoustics,	Inc.	(“WAI”)	warrants	to	the	original	end	user	(“Customer”)	that	
new	WAI	branded	products	will	be	 free	 from	defects	 in	workmanship	and	materials,	under	
normal	use.	Refer	to	the	following	table	for	the	applicable	warranty	period	from	the	original	
date	of	purchase.	
	

Hardware	Limited	Warranty	

Product Components Hardware Warranty Period 

Song Meter SMZC  
Recorder  

All components including microphone and 
accessories 

1 Year 

	
WAI	warrants	refurbished	WAI	products,	marked	and	sold	as	such,	for	ninety	(90)	days	from	
the	original	purchase	date.	
	
Software:	 WAI	 warrants	 to	 Customer	 that	 any	 WAI	 branded	 software	 will	 perform	 in	
substantial	conformance	to	their	program	specifications	for	a	period	of	ninety	(90)	days	from	
the	 date	 of	 original	 purchase.	WAI	warrants	 the	media	 containing	 software	 against	 failure	
during	the	warranty	period.	WAI	makes	no	warranty	or	representation	that	the	operation	of	
the	software	products	will	be	uninterrupted	or	error	free,	or	that	all	defects	in	the	software	
products	will	be	corrected.	
	
Exclusions:	This	warranty	excludes	(1)	physical	damage	to	the	surface	of	the	product,	including	
cracks	or	 scratches	on	 the	outside	casing;	 (2)	damage	caused	by	misuse,	neglect,	 improper	
installation	or	testing,	unauthorized	attempts	to	open,	repair,	or	modify	the	product,	or	any	
other	cause	beyond	the	range	of	the	intended	use;	(3)	damage	caused	by	accident,	fire,	power	
changes,	other	hazards,	or	acts	of	God;	or	(4)	use	of	the	product	with	any	non-WAI	device	or	
service	if	such	device	or	service	causes	the	problem.	
	
Any	third	party	products,	including	software,	included	with	WAI	products	are	not	covered	by	
this	WAI	warranty	and	WAI	makes	no	representations	or	warranties	on	behalf	of	such	third	
parties.	Any	warranty	on	such	products	is	from	the	supplier	or	licensor	of	the	product.	
	
No	 warranty	 is	 provided	 by	 WAI	 unless	 the	 product	 was	 purchased	 from	 an	 authorized	
distributor	or	authorized	reseller.	
	
Exclusive	Remedies:	Should	a	covered	defect	occur	during	the	warranty	period	and	you	notify	
WAI,	your	sole	and	exclusive	remedy	shall	be,	at	WAI’s	sole	option	and	expense,	to	repair	or	
replace	the	product	or	software.	If	WAI	cannot	reasonably	repair	nor	replace	then	WAI	may,	in	
its	sole	discretion,	refund	the	purchase	price	paid	for	the	product.	Replacement	products	or	
parts	may	be	new	or	reconditioned	or	comparable	versions	of	the	defective	item.	WAI	warrants	
any	 replaced	 or	 repaired	 product,	 part,	 or	 software	 for	 a	 period	 of	 ninety	 (90)	 days	 from	
shipment,	or	through	the	end	of	the	original	warranty,	whichever	is	longer.	
	
Obtaining	 Warranty	 Service:	 Customer	 should	 refer	 to	 the	 WAI	 website	 at	
www.wildlifeacoustics.com/support/contact-support	 for	 information	 on	 obtaining	warranty	
service	authorization.	Methods	for	obtaining	warranty	service	may	vary	depending	on	whether	
purchases	were	made	from	an	authorized	provider	of	WAI	products	or	from	WAI	directly.	All	
requests	 for	 warranty	 service	 authorization	must	 be	made	 within	 the	 applicable	 warranty	
period.	 Dated	 proof	 of	 original	 purchase	 will	 be	 required.	 Products	 or	 parts	 shipped	 by	
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Customer	to	WAI	must	be	sent	postage-paid	and	packaged	appropriately	for	safe	shipment.	
WAI	 is	 not	 responsible	 for	 Customer	 products	 received	 without	 a	 warranty	 service	
authorization	 and	 may	 be	 rejected.	 Repaired	 or	 replacement	 products	 will	 be	 shipped	 to	
Customer	at	WAI	expense.	All	products	or	parts	that	are	replaced	become	the	property	of	WAI.	
WAI	shall	not	be	responsible	for	Customer	software,	firmware,	information,	or	memory	data	
contained	in,	stored	on,	or	integrated	with	any	products	returned	to	WAI	for	repair,	whether	
under	warranty	or	not.	The	repair	and	replacement	process	for	products	or	parts	in	locations	
outside	of	the	United	States	will	vary	depending	on	Customer’s	location.	
	
Warranties	Exclusive:	THE	FOREGOING	WARRANTIES	AND	REMEDIES	ARE	EXCLUSIVE	AND	IN	
LIEU	OF	ALL	OTHER	WARRANTIES,	TERMS	OR	CONDITIONS,	EXPRESS,	IMPLIED	OR	STATUTORY,	
INCLUDING	 WARRANTIES	 OF	 MERCHANTABILITY,	 FITNESS	 FOR	 A	 PARTICULAR	 PURPOSE,	
ACCURACY,	 CORRESPONDENCE	 WITH	 DESCRIPTION,	 SATISFACTORY	 QUALITY	 AND	 NON-
INFRINGEMENT,	ALL	OF	WHICH	ARE	EXPRESSLY	DISCLAIMED	BY	WAI	AND	ITS	SUPPLIERS.	
	
Limitations	of	Liability:	NEITHER	WAI	NOR	ITS	SUPPLIERS	SHALL	BE	LIABLE	FOR	INCIDENTAL,	
CONSEQUENTIAL,	 INDIRECT,	 SPECIAL,	 OR	 PUNITIVE	 DAMAGES	 OF	 ANY	 KIND,	 LOSS	 OF	
INFORMATION	OR	DATA,	LOSS	OF	REVENUE,	LOSS	OF	BUSINESS	OR	OTHER	FINANCIAL	LOSS	
ARISING	OUT	OF	OR	IN	CONNECTION	WITH	THE	SALE	OR	USE	OF	THIS	PRODUCT,	WHETHER	
BASED	 IN	CONTRACT,	 TORT	 (INCLUDING	NEGLIGENCE),	 STRICT	PRODUCT	 LIABILITY	OR	ANY	
OTHER	THEORY,	EVEN	IF	WAI	HAS	BEEN	ADVISED	OF	THE	POSSIBILITY	OF	SUCH	DAMAGES	AND	
EVEN	IF	ANY	LIMITED	REMEDY	SPECIFIED	IN	THIS	LICENCE	AGREEMENT	IS	DEEMED	TO	HAVE	
FAILED	 OF	 ITS	 ESSENTIAL	 PURPOSE.	 WAI’S	 ENTIRE	 LIABILITY	 SHALL	 BE	 LIMITED	 TO	
REPLACEMENT,	REPAIR,	OR	REFUND	OF	THE	PURCHASE	PRICE	PAID,	AT	WAI’S	OPTION.	IN	NO	
EVENT	SHALL	WAI’S	LIABILITY	FOR	ALL	DAMAGES	RELATED	TO	THE	PURCHASE	OF	PRODUCT	
EXCEED	THE	AMOUNT	PAID	FOR	THE	APPLICABLE	PRODUCT.	THE	FOREGOING	LIMITATIONS	
WILL	APPLY	EVEN	IF	THE	ABOVE	STATED	REMEDY	FAILS	OF	ITS	ESSENTIAL	PURPOSE.	
	
Disclaimer:	Some	countries,	 states,	or	provinces	do	not	allow	the	exclusion	or	 limitation	of	
implied	 warranties	 or	 the	 limitation	 of	 incidental	 or	 consequential	 damages	 so	 the	 above	
limitations	and	exclusions	may	be	limited	in	their	application	to	you.	When	implied	warranties	
may	not	be	excluded	in	their	entirety,	they	will	be	 limited	to	the	duration	of	the	applicable	
written	warranty.	This	warranty	gives	you	specific	legal	rights;	you	may	have	other	rights	that	
may	vary	depending	on	local	law.	Your	statutory	rights	are	not	affected.	
	
Governing	Law:	This	Limited	Warranty	shall	be	governed	by	the	laws	of	the	Commonwealth	of	
Massachusetts,	U.S.A.,	and	by	the	laws	of	the	United	States,	excluding	their	conflicts	of	laws	
principles.	The	United	Nations	Convention	on	Contracts	for	the	International	Sale	of	Goods	is	
hereby	excluded	in	its	entirety	from	application	to	this	Limited	Warranty.	
	
Wildlife	Acoustics,	Inc.	
3	Clock	Tower	Place,	Suite	210	
Maynard,	MA	01754-2549	United	States	of	America	
www.wildlifeacoustics.com	
	
August	14,	2014	

11.2 Declaration	of	Conformity	(EN	45014)	
Manufacturer:		 Wildlife	Acoustics,	Inc.		
	 3	Clock	Tower	Place,	Suite	210	
	 Maynard,	MA	01754	
	 United	States	of	America	
	 	
	
Declares	that	the	following	product:		
	 Product	Name:	Song	Meter		
	 Product	Model	Number:	Song	Meter	SMZC		
	 Product	Type:	Bioacoustics	Recorder	
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Conforms	to	the	appropriate	country	standards	and	governing	regulations	listed	below	and/or	
on	 the	 following	 page.	 As	 the	 manufacturer,	 we	 are	 fully	 responsible	 for	 the	 design	 and	
production	of	the	above-mentioned	equipment.	
	
Federal	Communications	Commission	Rules	Part	15,	Class	B	
	
AS/NZS	CISPR	11,	2011,	Industrial,	scientific	and	medical	(ISM)	radio-frequency	equipment	–	
electromagnetic	disturbance	characteristics	–	limits	and	methods	of	measurement,	Class	B	
	
EN	55011,	2009/A1,	2010,	Industrial,	scientific	and	medical	(ISM)	radio-frequency	equipment	
–	Electromagnetic	disturbance	characteristics	–	Limits	and	methods	of	measurement,	Class	B	
	
ICES-003,	2004,	Industry	Canada,	Interference-Causing	Equipment	Standard,	Digital	Apparatus,	
Class	B	
	
EN61326,	 2006	 Electrical	 Equipment	 for	 Measurement,	 Control	 and	 Laboratory	 use	 EMC	
Requirements	(EMC	Directive	2004/108/EC)	
	
EN61000-4-2	Electrostatic	Discharge	
	
EN61000-4-3	Radiated	Electromagnetic	Fields	
	
This	product	was	tested	in	a	typical	configuration.	

	
Ian	Agranat,	President	
Wildlife	Acoustics,	Inc.	
August	14,	2014	

11.3 Electromagnetic	Interference	
This	equipment	has	been	tested	and	found	to	comply	with	the	limits	for	a	Class	B	digital	device,	
pursuant	to	Part	15	of	the	FCC	Rules.		
	
These	limits	are	designed	to	provide	reasonable	protection	against	harmful	interference	when	
the	equipment	is	operated	in	a	commercial	environment.	This	equipment	generates,	uses,	and	
can	 radiate	 radio	 frequency	 energy	 and,	 if	 not	 installed	 and	 used	 in	 accordance	 with	 the	
instruction	manual,	may	cause	harmful	 interference	to	radio	communications.	Operation	of	
this	equipment	in	a	residential	area	is	likely	to	cause	harmful	interference	in	which	case	the	
user	will	be	required	to	correct	the	interference	at	his	own	expense.	
	
Changes	 or	modifications	 not	 expressly	 approved	by	Wildlife	Acoustics,	 Inc.	 could	 void	 the	
user's	authority	to	operate	the	equipment.	
	
Note:	Use	of	ferrite	clamped	cables	are	required	to	comply	with	the	Class	B	limits	in	part	15	of	
the	FCC	rules.	A	Fair-Rite	0431164181	ferrite	clamp	(or	equivalent)	must	be	placed	on	each	
cable	near	the	recorder	with	the	ferrite	residing	within	one	 loop	of	the	cable.	This	clamp	is	
provided	with	all	cables	sold	by	Wildlife	Acoustics.	
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